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1 Introduction to Moderation SDK

Overview of Content Moderation
Content Moderation adopts image, text, audio, audio stream, and video detection
technologies that detect pornography. This reduces potential business risks.

Content Moderation provides services through open application programming
interfaces (APIs). You can obtain the inference results by accessing and calling
APIs in real time. It helps you collect key data automatically and build an
intelligent service system, thereby improving service efficiency.

SDK Overview
Content Moderation Software Development Kit (Moderation SDK for short)
encapsulates the RESTful APIs provided by Content Moderation to simplify
application development. You can add dependencies or download SDKs to call
APIs to use Content Moderation.

Mappings Between Services and APIs
Table 1-1 lists the mappings between the Content Moderation sub-services and
APIs.

Table 1-1 Mappings between services and APIs

Service API

Text Moderation (V3) POST /v3/{project_id}/moderation/text

Image Moderation (V3) POST /v3/{project_id}/moderation/
image

Creating an Audio Moderation Job POST /v3/{project_id}/moderation/
audio/jobs

Querying an Audio Moderation Job GET /v3/{project_id}/moderation/
audio/jobs/{job_id}

Creating a Video Moderation Job POST /v3/{project_id}/moderation/
video/jobs

Content Moderation
SDK Reference 1 Introduction to Moderation SDK
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Service API

Querying a Video Moderation Job GET /v3/{project_id}/moderation/
video/jobs/{job_id}

Creating an Audio Stream Moderation
Job

POST /v3/{project_id}/moderation/
audio-stream/jobs

Querying an Audio Stream Moderation
Job

POST /v3/{project_id}/moderation/
audio-stream/jobs/stop/{job_id}

Content Moderation
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2 Applying for a Service

Before using a service, you need to apply for it.

For details about how to apply for a service, see Applying for a Service in the
Content Moderation API Reference.

NO TE

If you do not apply for a service, the following error message is displayed:
ClientRequestException {
httpStatusCode: 400
errorCode: ModelArts.4204
errorMsg: Request API error. The API 1c641f1e-5418-4997-a82e-f5869d4eaef2 is not
subscribed.
requestId: 7f7640da09335e93290f95d0d0247a27
}

Content Moderation
SDK Reference 2 Applying for a Service
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3 Obtaining Authentication Information

Step 1 Log in to the management console.

Step 2 Hover the cursor on the username and select My Credentials from the drop-down
list.

Step 3 Click the Access Keys tab and then click Add Access Key.

Step 4 Enter the verification code sent to your mail or mobile phone.

Step 5 Click OK to download the AK/SK of the authentication account. The AK/SK data is
saved in a local file. Keep the file secure.

----End

Content Moderation
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4 Preparing the Environment

Table 4-1 lists the environments you need to prepare when using Content
Moderation SDKs of different programming languages.

Table 4-1 Development environment

Progra
mming
Langua
ge

Item Description

Java Installing
JDK

An environment used for developing Java applications.
Java JDK 1.8 and later versions are supported. You are
advised to use the Java SDK by installing dependencies
through Apache Maven.

Python Installing
Python

Python 3.3 and later versions are supported.

.NET Installing .N
ET

.NET Standard 2.0 and later versions, and C# 4.0 and
later versions are supported.

Go Installing
GO

Go 1.14 and later versions are supported.

PHP Installing
PHP

The php.7.x version is recommended.

Node.js Installing
Node.js

The Node.js 8.x version is supported.

Content Moderation
SDK Reference 4 Preparing the Environment
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5 Using the SDK (Java)

5.1 Preparing a Java Development Environment
Moderation Java SDK uses Java SE Development Kit 8 (JDK 8) or later. The
following uses JDK 8 (Windows x64) running on Windows 7 as an example. If you
have downloaded the JDK and configured the environment, skip this section.

Step 1 Download the JDK file.

Step 2 After the JDK file is downloaded, install the JDK as prompted. For example, install
the JDK to the C:\Program Files\Java\jdk1.8.0_131 directory on the local PC.

Step 3 Right-click Computer, choose Properties > Advanced System Settings >
Environment Variables, and perform the following operations to configure Java
environment variables:

1. Create system variable JAVA_HOME whose value is the JDK installation path.
2. Add %JAVA_HOME%\bin;%JAVA_HOME%\jre\bin to Path. Separate

multiple values with semicolons (;).
3. Create system variable CLASSPATH whose value is %JAVA_HOME%\lib

\dt.jar;%JAVA_HOME%\lib\tools.jar.

Step 4 Open the command line interface (CLI) and run java -version. If the information
shown in Figure 5-1 is displayed, the configuration is successful.

Figure 5-1 Java version information

----End

Content Moderation
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5.2 Obtaining and Installing the Java SDK
You are advised to use the Java SDK for Content Moderation by installing
dependencies through Apache Maven.

Step 1 Download and install Apache Maven on your operating system.

Step 2 After installing and configuring Maven, run the mvn -v command. Maven is
installed successfully if the following information is displayed.

Step 3 Add dependencies to an existing Maven project or use an integrated development
environment (IDE) to create a Maven project.

To create a Maven project using IntelliJ IDEA (an example IDE), perform the
following steps (skip if you already have a Maven project):

1. Start IntelliJ IDEA.
2. Choose File > New > project...
3. In the displayed New Project dialog box, click Maven and then Next.
4. Specify GroupId and ArtifactId, and click Next.
5. Specify Project name and Project location, and click Finish.

Step 4 Add dependency items to the pom.xml file of the Maven project.

The following is the dependency for Content Moderation SDK 3.0.55:
<dependency>
    <groupId>com.huaweicloud.sdk</groupId>
    <artifactId>huaweicloud-sdk-moderation</artifactId>
    <version>3.0.55</version>
</dependency>

The following sample code uses the fastjson dependency (ignore and delete it if it
is not required):

<dependency>
    <groupId>com.alibaba</groupId>
    <artifactId>fastjson</artifactId>
    <version>1.2.70</version>
</dependency>

----End

5.3 SDK Calling Example

5.3.1 Moderation (Text)

Content Moderation
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5.3.1.1 Text Moderation (V3)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
In the sample code, you can use the withText method of the
TextDetectionDataReq class to configure the text to be detected. After the
configuration is complete, run the code.
package com.huaweicloud.sdk.test;

import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.core.region.Region;
import com.huaweicloud.sdk.moderation.v3.*;
import com.huaweicloud.sdk.moderation.v3.model.*;

public class RunTextModerationSolution {

    public static void main(String[] args) {
       // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK 
and store them in the configuration file or environment variables.
       // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        String ak = System.getenv("HUAWEICLOUD_SDK_AK");
        String sk = System.getenv("HUAWEICLOUD_SDK_SK");

        ICredential auth = new BasicCredentials()
                .withAk(ak)
                .withSk(sk);

        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx"))  //Replace xxx with the service region, for 
example, ap-southeast-3.
                .build();
        RunTextModerationRequest request = new RunTextModerationRequest();
        TextDetectionReq body = new TextDetectionReq();
        TextDetectionDataReq databody = new TextDetectionDataReq();
        databody.withText("test");
        body.withData(databody);
        body.withEventType("comment");
        request.withBody(body);
        try {
            RunTextModerationResponse response = client.runTextModeration(request);
            System.out.println(response.toString());
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The text
moderation result is displayed on the console.
class RunTextModerationResponse {
    requestId: 308b6ad2740e51de73597da9fdc94ee1
    result: class TextDetectionResult {
        suggestion: pass

Content Moderation
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        label: normal
        details: []
    }
}

5.3.2 Moderation (Image)

5.3.2.1 Image Moderation (V3)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
In the sample code, you can use the withUrl or withImage method of the
ImageDetectionReq class to set image information (either the image or url
parameter). The following uses url as an example. After the configuration is
complete, run the code.

package com.huaweicloud.sdk.test;

import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v3.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v3.*;
import com.huaweicloud.sdk.moderation.v3.model.*;

import java.util.List;
import java.util.ArrayList;

public class CheckImageModerationSolution {

    public static void main(String[] args) {
       // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK 
and store them in the configuration file or environment variables.
       // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        String ak = System.getenv("HUAWEICLOUD_SDK_AK");
        String sk = System.getenv("HUAWEICLOUD_SDK_SK");
        String projectId = "project_id";

        ICredential auth = new BasicCredentials()
                .withProjectId(projectId)
                .withAk(ak)
                .withSk(sk);

        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx"))  //Replace xxx with the service region, for 
example, ap-southeast-3.
                .build();
        CheckImageModerationRequest request = new CheckImageModerationRequest();
        ImageDetectionReq body = new ImageDetectionReq();
        List<String> listbodyCategories = new ArrayList<>();
        listbodyCategories.add("porn");
        body.withUrl("http://www.xxxx.xxxx");
        body.withCategories(listbodyCategories);
        body.withEventType("head_image");
        request.withBody(body);
        try {
            CheckImageModerationResponse response = client.checkImageModeration(request);
            System.out.println(response.toString());
        } catch (ConnectionException e) {
            e.printStackTrace();

Content Moderation
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        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The
image moderation result is displayed on the console.
class CheckImageModerationResponse {
    requestId: 63b6b19eb9fa1db05d2f87f970472995
    result: class ImageDetectionResult {
        suggestion: block
        category: image_text
        details: [class ImageDetectionResultDetail {
            suggestion: block
            category: image_text
            confidence: 1.0
            faceLocation: null
            qrLocation: class QRLocationDetail {
                topLeftX: 74
                topLeftY: 66
                bottomRightX: 151
                bottomRightY: 142
            }
            qrContent: http://xxxxxxxxxx
            segments: null
            label: qr_code
        }, class ImageDetectionResultDetail {
            suggestion: block
            category: image_text
            confidence: 0.98779297
            faceLocation: null
            qrLocation: null
            qrContent: null
            segments: null
            label: ad
        }, class ImageDetectionResultDetail {
            suggestion: block
            category: image_text
            confidence: 1.0
            faceLocation: null
            qrLocation: null
            qrContent: null
            segments: null
            label: qr_code
        }]
        ocrText: xxxxxxxxx
    }
}

5.3.3 Moderation (Video)

5.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withUrls of the
RunCreateVideoModerationJobRequest class to configure the URL of the video
to be reviewed (only the URL mode is supported). After the configuration is
complete, run the code.

Content Moderation
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package com.huaweicloud.sdk.test;
 
import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v3.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v3.*;
import com.huaweicloud.sdk.moderation.v3.model.*;
 
import java.util.List;
import java.util.ArrayList;
 
public class RunCreateVideoModerationJobSolution {
 
    public static void main(String[] args) {
       // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK 
and store them in the configuration file or environment variables.
       // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        String ak = System.getenv("HUAWEICLOUD_SDK_AK");
        String sk = System.getenv("HUAWEICLOUD_SDK_SK");
 
        ICredential auth = new BasicCredentials()
                .withAk(ak)
                .withSk(sk);
 
        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx")) //Replace xxx with the service region, for 
example, ap-southeast-3.
                .build();
        RunCreateVideoModerationJobRequest request = new RunCreateVideoModerationJobRequest();
        VideoCreateRequest body = new VideoCreateRequest();
        List<VideoCreateRequest.AudioCategoriesEnum> listbodyAudioCategories = new ArrayList<>();
        listbodyAudioCategories.add(VideoCreateRequest.AudioCategoriesEnum.fromValue("porn"));
        List<VideoCreateRequest.ImageCategoriesEnum> listbodyImageCategories = new ArrayList<>();
        listbodyImageCategories.add(VideoCreateRequest.ImageCategoriesEnum.fromValue("porn"));
        VideoCreateRequestData databody = new VideoCreateRequestData();
        databody.withUrl("http://xxx.xx.xxxx")
            .withFrameInterval(5.5f);
        body.withCallback("http://xxx.xx.xxxx");
        body.withAudioCategories(listbodyAudioCategories);
        body.withImageCategories(listbodyImageCategories);
        body.withEventType(VideoCreateRequest.EventTypeEnum.fromValue("default"));
        body.withData(databody);
        request.withBody(body);
        try {
            RunCreateVideoModerationJobResponse response = 
client.runCreateVideoModerationJob(request);
            System.out.println(response.toString());
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. The console returns the submission result of the creation request and the
video moderation job creation result.
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class RunCreateVideoModerationJobResponse {
    requestId: 5e353de1badd90049a2ac3d2e3ee925e
    jobId: 01663171200_48ce5a21498e47af8f2a49773c3d0fce
}

5.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withJobId of the
RunQueryVideoModerationJobRequest class to configure the ID of the review
task. After the configuration is complete, run the code.

package com.huaweicloud.sdk.test;
 
import com.huaweicloud.sdk.core.auth.ICredential;
import com.huaweicloud.sdk.core.auth.BasicCredentials;
import com.huaweicloud.sdk.core.exception.ConnectionException;
import com.huaweicloud.sdk.core.exception.RequestTimeoutException;
import com.huaweicloud.sdk.core.exception.ServiceResponseException;
import com.huaweicloud.sdk.moderation.v3.region.ModerationRegion;
import com.huaweicloud.sdk.moderation.v3.*;
import com.huaweicloud.sdk.moderation.v3.model.*;
 
public class RunQueryVideoModerationJobSolution {
 
    public static void main(String[] args) {
       // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK 
and store them in the configuration file or environment variables.
       // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        String ak = System.getenv("HUAWEICLOUD_SDK_AK");
        String sk = System.getenv("HUAWEICLOUD_SDK_SK");
 
        ICredential auth = new BasicCredentials()
                .withAk(ak)
                .withSk(sk);
 
        ModerationClient client = ModerationClient.newBuilder()
                .withCredential(auth)
                .withRegion(ModerationRegion.valueOf("xxx")) //Replace xxx with the service region, for 
example, ap-southeast-3.
                .build();
        RunQueryVideoModerationJobRequest request = new RunQueryVideoModerationJobRequest();
        request.withJobId("jobId");
        try {
            RunQueryVideoModerationJobResponse response = 
client.runQueryVideoModerationJob(request);
            System.out.println(response.toString());
        } catch (ConnectionException e) {
            e.printStackTrace();
        } catch (RequestTimeoutException e) {
            e.printStackTrace();
        } catch (ServiceResponseException e) {
            e.printStackTrace();
            System.out.println(e.getHttpStatusCode());
            System.out.println(e.getErrorCode());
            System.out.println(e.getErrorMsg());
        }
    }
}

2. The console returns the submission result of the query request and the video
moderation job query result.
class RunQueryVideoModerationJobResponse {
    requestId: a6dcb5c9f993efb977c8898e1ef91c87

Content Moderation
SDK Reference 5 Using the SDK (Java)

Issue 01 (2025-07-02) Copyright © Huawei Technologies Co., Ltd. 12

https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0072.html#section4
https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0072.html#section4


    jobId: 01663171200_48ce5a21498e47af8f2a49773c3d0fce
    status: running
    requestParams: class VideoModerationResultRequestParams {
        data: class VideoModerationResultRequestParamsData {
            url: http://xxx.xx.xxxx
            frameInterval: 5
        }
        eventType: default
        imageCategories: [porn, image_text, terrorism]
        audioCategories: [ad, porn]
        callback: http://xxx.xx.xxxx
    }
    createTime: null
    updateTime: 2022-09-15T14:08:06.006Z
    result: null
}
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6 Using the Python SDK

6.1 Preparing a Python Development Environment
To use the Python SDK of Content Moderation, you need to configure the Python
development environment.

1. Download Python of a proper version from Python official website and
install it. Python3.3 or later is recommended. This section uses Python 3.7 as
an example.

2. Download the latest version of PyCharm from PyCharm's official website.
3. Start the PyCharm development tool and choose File > Settings > Project

Interpreter to configure the Python environment.
4. Select the Python installation path. See Figure 6-1. After selecting the target

Python, click Apply at the bottom of the page to complete the configuration.
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Figure 6-1 Configuring the python environment using PyCharm

6.2 Obtaining and Installing the Python SDK
To obtain and install the Python SDK, you are advised to use pip commands or
PyCharm. You need to install the huaweicloudsdkcore and
huaweicloudsdkmoderation packages as follows:

Install the Python SDK using pip commands:
# Install the huaweicloudsdkcore package.
pip install huaweicloudsdkcore

# Install the huaweicloudsdkmoderation package.
pip install huaweicloudsdkmoderation

To install the Python SDK using PyCharm, perform the following steps:

1. Start PyCharm and choose File > Settings...
2. Choose Python Interpreter.
3. Click +, search for huaweicloudsdkcore and hua, select the

package .NEweicloudsdkmoderation, and click Install Package in the lower
left corner to install it.
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Figure 6-2 Installing the Python SDK for Content Moderation using PyCharm

6.3 SDK Calling Example

6.3.1 Moderation (Text)

6.3.1.1 Text Moderation (V3)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
Change the value of text in TextDetectionDataReq in the sample code to the
text to be detected. Then run the code.
# coding: utf-8
 
from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkmoderation.v3.region.moderation_region import ModerationRegion
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v3 import *
import os
 
if __name__ == "__main__":
    # Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
    # In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
    ak = os.getenv("HUAWEICLOUD_SDK_AK")
    sk = os.getenv("HUAWEICLOUD_SDK_SK")
 
    credentials = BasicCredentials(ak, sk) \
 
    client = ModerationClient.new_builder() \
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        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx"))\        
        .build()
    # Replace xxx with the service region, for example, ap-southeast-3.
    try:
        request = RunTextModerationRequest()
        databody = TextDetectionDataReq(
            text="test"
        )
        request.body = TextDetectionReq(
            data=databody,
            event_type="comment"
        )
        response = client.run_text_moderation(request)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. If 200 is displayed on the console, the code is successfully executed. The text
moderation result is displayed on the console.
{"request_id": "d81702cfd3599e103030c3d52d6f955f", "result": {"suggestion": "pass", "label": 
"normal", "details": []}}

6.3.2 Moderation (Image)

6.3.2.1 Image Moderation (V3)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Change the value of url or image in ImageDetectionReq in the sample code
to configure the image information. Then run the code.

# coding: utf-8
 
from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkmoderation.v3.region.moderation_region import ModerationRegion
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v3 import *
import os
 
if __name__ == "__main__":
    # Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
    # In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
    ak = os.getenv("HUAWEICLOUD_SDK_AK")
    sk = os.getenv("HUAWEICLOUD_SDK_SK")
    projectId = "project_id"
 
    credentials = BasicCredentials(ak, sk, projectId) \
 
    client = ModerationClient.new_builder() \
        .with_credentials(credentials) \
        .with_region(ModerationRegion.value_of("xxx")) \   
        .build()
    # Replace xxx with the service region, for example, ap-southeast-3.
    try:
        request = CheckImageModerationRequest()
        listCategoriesbody = [
            "porn"
        ]
        request.body = ImageDetectionReq(
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            url="http://www.xxxx.xxxx",
            categories=listCategoriesbody,
            event_type="head_image"
        )
        response = client.check_image_moderation(request)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. If 200 is displayed on the console, the code is successfully executed. The
image moderation result is displayed on the console.
{"request_id": "69b424920668cb15e6d25eef879a023b", "result": {"suggestion": "block", "category": 
"image_text", "details": [{"suggestion": "block", "category": "image_text", "confidence": 1.0, 
"qr_location": {"top_left_x": 74, "top_left_y": 66, "bottom_right_x": 151, "bottom_right_y": 142}, 
"qr_content": "http://xxxxxx/xxxxx", "label": "qr_code"}, {"suggestion": "block", "category": 
"image_text", "confidence": 0.98779297, "label": "ad"}, {"suggestion": "block", "category": 
"image_text", "confidence": 1.0, "label": "qr_code"}], "ocr_text": "xxxxxxxxx"}}

6.3.3 Moderation (Video)

6.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withUrls of the
RunCreateVideoModerationJobRequest class to configure the URL of the video
to be reviewed (only the URL mode is supported). After the configuration is
complete, run the code.

# coding: utf-8
 
from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkmoderation.v3.region.moderation_region import ModerationRegion
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v3 import *
import os
 
if __name__ == "__main__":
    # Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
    # In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
    ak = os.getenv("HUAWEICLOUD_SDK_AK")
    sk = os.getenv("HUAWEICLOUD_SDK_SK")
    credentials = BasicCredentials(ak, sk) \
 
    client = ModerationClient.new_builder() \
       .with_credentials(credentials) \
       .with_region(ModerationRegion.value_of("xxx")) \    
       .build()
    # Replace xxx with the service region, for example, ap-southeast-3.
    try:
        request = RunCreateVideoModerationJobRequest()
        listAudioCategoriesbody = [
            "porn"
        ]
        listImageCategoriesbody = [
            "porn"
        ]
        databody = VideoCreateRequestData(
            url="http://xxx.xx.xxxx",
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            frame_interval=5.5
        )
        request.body = VideoCreateRequest(
            callback="http://xxx.xx.xxxx",
            audio_categories=listAudioCategoriesbody,
            image_categories=listImageCategoriesbody,
            event_type="default",
            data=databody
        )
        response = client.run_create_video_moderation_job(request)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. The console returns the submission result of the creation request and the
video moderation job creation result.
{"request_id": "dbbcb75d1a174bfa899a38be38fdd107", "job_id": "xxx"}

6.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withJobId of the
RunQueryVideoModerationJobRequest class to configure the ID of the review
task. After the configuration is complete, run the code.

# coding: utf-8
 
from huaweicloudsdkcore.auth.credentials import BasicCredentials
from huaweicloudsdkmoderation.v3.region.moderation_region import ModerationRegion
from huaweicloudsdkcore.exceptions import exceptions
from huaweicloudsdkmoderation.v3 import *
import os
 
if __name__ == "__main__":
    # Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
    # In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
    ak = os.getenv("HUAWEICLOUD_SDK_AK")
    sk = os.getenv("HUAWEICLOUD_SDK_SK")
    credentials = BasicCredentials(ak, sk) \
 
    client = ModerationClient.new_builder() \
       .with_credentials(credentials) \
       .with_region(ModerationRegion.value_of("xxx")) \   
       .build()
    # Replace xxx with the service region, for example, ap-southeast-3.
    try:
        request = RunQueryVideoModerationJobRequest()
        request.job_id = "xxx"   //Enter your job ID.
        response = client.run_query_video_moderation_job(request)
        print(response)
    except exceptions.ClientRequestException as e:
        print(e.status_code)
        print(e.request_id)
        print(e.error_code)
        print(e.error_msg)

2. The console returns the submission result of the query request and the video
moderation job query result.
{"request_id":"xxxx","job_id":"xxx","status":"succeeded","request_params":{"data":
{"url":"xxxx","frame_interval":5},"event_type":"default","image_categories":
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["porn","terrorism","image_text"],"audio_categories":
["porn","ad","moan","abuse"],"callback":"xxx"},"create_time":"2022-07-30T08:57:11.011Z","update_tim
e":"2022-07-30T08:57:14.014Z","result":{"suggestion":"block","image_detail":
[{"suggestion":"block","category":"porn","ocr_text":"123","time":0,"detail":
[{"confidence":0.676015138626099,"category":"porn","suggestion":"block","label":"pornography"},
{"confidence":0.666015138626099,"category":"porn","suggestion":"review","label":"sexy_female"},
{"confidence":0.666015138626099,"category":"xxx","suggestion":"block","label":"leader"},
{"confidence":0.691423773765564,"category":"xxx","suggestion":"block","face_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":200,"bottom_right_y":240},"label":"leader"},
{"confidence":0.691423773765564,"category":"porn","suggestion":"block","face_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000},"label":"leader"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code","qr_c
ontent":"xxxxxxxxx","qr_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000}},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"porn","segme
nts":[{"segment":"xxx"},{"segment":"xx"}]}]}],"audio_detail":
[{"suggestion":"block","label":"porn","audio_text":"xxxxx","end_time":10,"start_time":0,"detail":
[{"confidence":0.999117187582349,"label":"porn","suggestion":"block","segments":
[{"segment":"xxx"}]},{"confidence":0.885117187582349,"label":"porn","suggestion":"block"}]}]}}

Content Moderation
SDK Reference 6 Using the Python SDK

Issue 01 (2025-07-02) Copyright © Huawei Technologies Co., Ltd. 20



7 Using the .NET SDK

7.1 Preparing a .NET Development Environment
To use the .NET SDK of Content Moderation, you need to configure the .NET
development environment.

1. Download the latest Visual Studio from the Visual Studio official website.
2. Click the .exe file to start installation.
3. During the installation, select ASP.NET and web development on the

Workloads tab page.

7.2 Importing a .NET SDK into a .NET Environment
You can install the .Net SDK using commands or Visual Studio.

// Use .NET CLI to install the .Net SDK.
dotnet add package HuaweiCloud.SDK.Core 
dotnet add package HuaweiCloud.SDK.Moderation

// Use Package Manager to install the .Net SDK.
Install-Package HuaweiCloud.SDK.Core 
dotnet add package HuaweiCloud.SDK.Moderation

If you use Visual Studio, choose Tools > NuGet Package Manager > Manage
NuGet Packages for Solution..., and search for and install
HuaweiCloud.SDK.Core and HuaweiCloud.SDK.Moderation.

7.3 SDK Calling Example

7.3.1 Moderation (Text)

7.3.1.1 Text Moderation (V3)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
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Change the value of Text in TextDetectionDataReq in the sample code to
the text to be detected. Then run the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V3;
using HuaweiCloud.SDK.Moderation.V3.Model;
 
namespace RunTextModerationSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
      //In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        string ak= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_AK", 
EnvironmentVariableTarget.Machine);
        string sk= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_SK", 
EnvironmentVariableTarget.Machine);
 
            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);
 
            var client = ModerationClient.NewBuilder()
            .WithCredential(auth)
            .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the service region, for 
example, ap-southeast-3.
            .WithHttpConfig(config)
            .Build();
 
            var req = new RunTextModerationRequest
            {
            };
            TextDetectionDataReq databody = new TextDetectionDataReq()
            {
                Text = "test"
            };
            req.Body = new TextDetectionReq()
            {
                Data = databody,
                EventType = "comment"
            };
 
            try
            {
                var resp = client.RunTextModeration(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
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                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The text
moderation result is displayed on the console.
200
 {
     "request_id":"d81702cfd3599e103030c3d52d6f955f",
     "result":{
         "suggestion":"pass",
         "label":"normal",
         "details":[]
     }
 }

7.3.2 Moderation (Image)

7.3.2.1 Image Moderation (V3)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Change the value of Image or Url in ImageDetectionReq in the sample code
to configure the image to be reviewed. Then run the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V3;
using HuaweiCloud.SDK.Moderation.V3.Model;
 
namespace CheckImageModerationSolution
{
    class Program
    {
        static void Main(string[] args)
        {
       //Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
      //In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        string ak= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_AK", 
EnvironmentVariableTarget.Machine);
        string sk= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_SK", 
EnvironmentVariableTarget.Machine);

            const string projectId = "project_id";
            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk, projectId);
 
            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();
 
            var req = new CheckImageModerationRequest
            {

Content Moderation
SDK Reference 7 Using the .NET SDK

Issue 01 (2025-07-02) Copyright © Huawei Technologies Co., Ltd. 23

https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0069.html#section5
https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0069.html#section5


            };
            List<string> listCategoriesbody = new List<string>();
            listCategoriesbody.Add("porn");
            req.Body = new ImageDetectionReq()
            {
                Url = "http://www.xxxx.xxxx",
                Categories = listCategoriesbody,
                EventType = "head_image"
            };
 
            try
            {
                var resp = client.CheckImageModeration(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
                  Console.WriteLine(resp);
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. If 200 is displayed on the console, the code is successfully executed. The
image moderation result is displayed on the console.
200
 {"request_id": "69b424920668cb15e6d25eef879a023b", "result": {"suggestion": "block", "category": 
"image_text", "details": [{"suggestion": "block", "category": "image_text", "confidence": 1.0, 
"qr_location": {"top_left_x": 74, "top_left_y": 66, "bottom_right_x": 151, "bottom_right_y": 142}, 
"qr_content": "http://xxxxxx/xxxxx", "label": "qr_code"}, {"suggestion": "block", "category": 
"image_text", "confidence": 0.98779297, "label": "ad"}, {"suggestion": "block", "category": 
"image_text", "confidence": 1.0, "label": "qr_code"}], "ocr_text": "xxxxxxxxx"}}

7.3.3 Moderation (Video)

7.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withUrls of the
RunCreateVideoModerationJobRequest class to configure the URL of the video
to be reviewed (only the URL mode is supported). After the configuration is
complete, run the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V3;
using HuaweiCloud.SDK.Moderation.V3.Model;
 
namespace RunCreateVideoModerationJobSolution
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{
    class Program
    {
        static void Main(string[] args)
        {
      //Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
      //In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        string ak= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_AK", 
EnvironmentVariableTarget.Machine);
        string sk= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_SK", 
EnvironmentVariableTarget.Machine);

 
            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);
 
            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();
 
            var req = new RunCreateVideoModerationJobRequest
            {
            };
            List<VideoCreateRequest.AudioCategoriesEnum> listAudioCategoriesbody = new 
List<VideoCreateRequest.AudioCategoriesEnum>();
            listAudioCategoriesbody.Add(VideoCreateRequest.AudioCategoriesEnum.FromValue("porn"));
            List<VideoCreateRequest.ImageCategoriesEnum> listImageCategoriesbody = new 
List<VideoCreateRequest.ImageCategoriesEnum>();
            listImageCategoriesbody.Add(VideoCreateRequest.ImageCategoriesEnum.FromValue("porn"));
            VideoCreateRequestData databody = new VideoCreateRequestData()
            {
                Url = "http://xxx.xx.xxxx",
                FrameInterval = 5.5
            };
            req.Body = new VideoCreateRequest()
            {
                Callback = "http://xxx.xx.xxxx",
                AudioCategories = listAudioCategoriesbody,
                ImageCategories = listImageCategoriesbody,
                EventType = VideoCreateRequest.EventTypeEnum.FromValue("default"),
                Data = databody
            };
 
            try
            {
                var resp = client.RunCreateVideoModerationJob(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
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            }
        }
    }
}

2. The console returns the submission result of the creation request and the
video moderation job creation result.
200
 {
    "request_id":"dbbcb75d1a174bfa899a38be38fdd107",
    "job_id":"xxx"
}

7.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withJobId of the
RunQueryVideoModerationJobRequest class to configure the ID of the review
task. After the configuration is complete, run the code.

using System;
using System.Collections.Generic;
using HuaweiCloud.SDK.Core;
using HuaweiCloud.SDK.Core.Auth;
using HuaweiCloud.SDK.Moderation;
using HuaweiCloud.SDK.Moderation.V3;
using HuaweiCloud.SDK.Moderation.V3.Model;

namespace RunQueryVideoModerationJobSolution
{
    class Program
    {
        static void Main(string[] args)
        {
      //Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
      //In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
        string ak= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_AK", 
EnvironmentVariableTarget.Machine);
        string sk= Environment.GetEnvironmentVariable("HUAWEICLOUD_SDK_SK", 
EnvironmentVariableTarget.Machine);

            var config = HttpConfig.GetDefaultConfig();
            config.IgnoreSslVerification = true;
            var auth = new BasicCredentials(ak, sk);

            var client = ModerationClient.NewBuilder()
                    .WithCredential(auth)
                    .WithRegion(ModerationRegion.ValueOf("xxx"))  //Replace xxx with the region where 
the service is located.
                    .WithHttpConfig(config)
                    .Build();

            var req = new RunQueryVideoModerationJobRequest
            {
                JobId = "xxxx"    //Enter your job ID.
            };

            try
            {
                var resp = client.RunQueryVideoModerationJob(req);
                var respStatusCode = resp.HttpStatusCode;
                Console.WriteLine(respStatusCode);
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Console.WriteLine(JsonConvert.DeserializeObject(resp.HttpBody));
            }
            catch (RequestTimeoutException requestTimeoutException)
            {
                Console.WriteLine(requestTimeoutException.ErrorMessage);
            }
            catch (ServiceResponseException clientRequestException)
            {
                Console.WriteLine(clientRequestException.HttpStatusCode);
                Console.WriteLine(clientRequestException.ErrorCode);
                Console.WriteLine(clientRequestException.ErrorMsg);
            }
            catch (ConnectionException connectionException)
            {
                Console.WriteLine(connectionException.ErrorMessage);
            }
        }
    }
}

2. The console returns the submission result of the query request and the video
moderation job query result.
200
{
    "request_id":"xxxx",
    "job_id":"xxx",
    "status":"succeeded",
    "request_params":{
        "data":{
            "url":"xxxx",
            "frame_interval":5
        },
        "event_type":"default",
        "image_categories":[
            "porn",
            "terrorism",
            "image_text"
        ],
        "audio_categories":[
            "porn",
            "ad",
            "moan",
            "abuse"
        ],
        "callback":"xxx"
    },
    "create_time":"2022-07-30T08:57:11.011Z",
    "update_time":"2022-07-30T08:57:14.014Z",
    "result":{
        "suggestion":"block",
        "image_detail":[
            {
                "suggestion":"block",
                "category":"porn",
                "ocr_text":"123",
                "time":0,
                "detail":[
                    {
                        "confidence":0.676015138626099,
                        "category":"porn",
                        "suggestion":"block",
                        "label":"pornography"
                    },
                    {
                        "confidence":0.666015138626099,
                        "category":"porn",
                        "suggestion":"review",
                        "label":"sexy_female"
                    },
                    {
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                        "confidence":0.666015138626099,
                        "category":"xxx",
                        "suggestion":"block",
                        "label":"leader"
                    },
                    {
                        "confidence":0.691423773765564,
                        "category":"xxx",
                        "suggestion":"block",
                        "face_location":{
                            "top_left_x":12,
                            "top_left_y":13,
                            "bottom_right_x":200,
                            "bottom_right_y":240
                        },
                        "label":"leader"
                    },
                    {
                        "confidence":0.691423773765564,
                        "category":"porn",
                        "suggestion":"block",
                        "face_location":{
                            "top_left_x":12,
                            "top_left_y":13,
                            "bottom_right_x":100,
                            "bottom_right_y":2000
                        },
                        "label":"leader"
                    },
                    {
                        "confidence":0.891423773765564,
                        "category":"image_text",
                        "suggestion":"block",
                        "label":"qr_code"
                    },
                    {
                        "confidence":0.891423773765564,
                        "category":"image_text",
                        "suggestion":"block",
                        "label":"qr_code",
                        "qr_content":"xxxxxxxxx",
                        "qr_location":{
                            "top_left_x":12,
                            "top_left_y":13,
                            "bottom_right_x":100,
                            "bottom_right_y":2000
                        }
                    },
                    {
                        "confidence":0.891423773765564,
                        "category":"image_text",
                        "suggestion":"block",
                        "label":"porn",
                        "segments":[
                            {
                                "segment":"xxx"
                            },
                            {
                                "segment":"xx"
                            }
                        ]
                    }
                ]
            }
        ],
        "audio_detail":[
            {
                "suggestion":"block",
                "label":"porn",
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                "audio_text":"xxxxx",
                "end_time":10,
                "start_time":0,
                "detail":[
                    {
                        "confidence":0.999117187582349,
                        "label":"porn",
                        "suggestion":"block",
                        "segments":[
                            {
                                "segment":"xxx"
                            }
                        ]
                    },
                    {
                        "confidence":0.885117187582349,
                        "label":"porn",
                        "suggestion":"block"
                    }
                ]
            }
        ]
    }
}
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8 Using the Go SDK

8.1 Preparing a Go Development Environment
To use the Go SDK of Image Recognition, you need to configure the Go
development environment. If the Go development environment has been installed,
skip this section.

1. Download Go 1.14 or a later version from the Go official website.

2. Install the downloaded Go in a specified path, for example, D:\develop\go.

3. Right-click Computer, choose Properties > Advanced System Settings >
Environment Variables, and perform the following operations:

a. Create system variable GOROOT whose value is the Go installation path.
Add environment variable GOPATH, which indicates the directory where
the Go project is located.

b. Append ;%GOROOT%\bin (path of the Go compiler) to the PATH
variable.

c. Append ;%GOROOT%\lib (path of the Go compiler) to the CLASSPATH
variable.

4. Download Visual Studio Code from its official website and install it.

5. Install the Go and Go Critic plug-ins.

8.2 Obtaining and Installing the Go SDK
1. Run the following command:

go get -u github.com/huaweicloud/huaweicloud-sdk-go-v3

8.3 SDK Calling Example

8.3.1 Moderation (Text)
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8.3.1.1 Text Moderation (V3)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
Change the value of Text in TextDetectionDataReq in the sample code to
the text to be detected. Then run the code.
package main
 
import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/region"
)
 
func main() {
   // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
   // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
   ak := os.Getenv("HUAWEICLOUD_SDK_AK")
   sk := os.Getenv("HUAWEICLOUD_SDK_SK")
 
    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()
 
    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("xxx")).  //Replace xxx with the service region, for example, ap-
southeast-3.
            WithCredential(auth).
            Build())
 
    request := &model.RunTextModerationRequest{}
    databody := &model.TextDetectionDataReq{
        Text: "text",
    }
    request.Body = &model.TextDetectionReq{
        Data: databody,
        EventType: "comment",
    }
    response, err := client.RunTextModeration(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }
}

2. The code is successfully executed if the text moderation result is displayed
on the console.
RunTextModerationResponse {"request_id": "d81702cfd3599e103030c3d52d6f955f", "result": 
{"suggestion": "pass", "label": "normal", "details": []}}

8.3.2 Moderation (Image)

8.3.2.1 Image Moderation (V3)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
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Use Url or Image to configure the image information (Url is used in the
sample code) and run the code.
package main

import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/region"
)

func main() {
   // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
   // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
   ak := os.Getenv("HUAWEICLOUD_SDK_AK")
   sk := os.Getenv("HUAWEICLOUD_SDK_SK")

    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        WithProjectId(projectId).
        Build()

    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("xxx")). //Replace xxx with the service region, for example, ap-
southeast-3.
            WithCredential(auth).
            Build())

    request := &model.CheckImageModerationRequest{}
    var listCategoriesbody = []string{
        "porn",
    }
    urlImageDetectionReq:= "http://www.xxxx.xxxx"
    request.Body = &model.ImageDetectionReq{
        Url: &urlImageDetectionReq,
        Categories: listCategoriesbody,
        EventType: "head_image",
    }
    response, err := client.CheckImageModeration(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }
}

2. The code is successfully executed if the image moderation result is displayed
on the console.
CheckImageModerationResponse 
{"request_id": "69b424920668cb15e6d25eef879a023b", "result": {"suggestion": "block", "category": 
"image_text", "details": [{"suggestion": "block", "category": "image_text", "confidence": 1.0, 
"qr_location": {"top_left_x": 74, "top_left_y": 66, "bottom_right_x": 151, "bottom_right_y": 142}, 
"qr_content": "http://xxxxxx/xxxxx", "label": "qr_code"}, {"suggestion": "block", "category": 
"image_text", "confidence": 0.98779297, "label": "ad"}, {"suggestion": "block", "category": 
"image_text", "confidence": 1.0, "label": "qr_code"}], "ocr_text": "xxxxxxxxx"}}

8.3.3 Moderation (Video)
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8.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withUrls of the
RunCreateVideoModerationJobRequest class to configure the URL of the video
to be reviewed (only the URL mode is supported). After the configuration is
complete, run the code.
package main
 
import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/region"
)
 
func main() {
   // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
   // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
   ak := os.Getenv("HUAWEICLOUD_SDK_AK")
   sk := os.Getenv("HUAWEICLOUD_SDK_SK")
 
    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()
 
    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("xxx")).   //Replace xxx with the service region, for example, ap-
southeast-3.
            WithCredential(auth).
            Build())
 
    request := &model.RunCreateVideoModerationJobRequest{}
    var listAudioCategoriesbody = []model.VideoCreateRequestAudioCategories{
        model.GetVideoCreateRequestAudioCategoriesEnum().PORN,
    }
    var listImageCategoriesbody = []model.VideoCreateRequestImageCategories{
        model.GetVideoCreateRequestImageCategoriesEnum().PORN,
    }
    frameIntervalData:= float32(5.5)
    databody := &model.VideoCreateRequestData{
        Url: "http://xxx.xx.xxxx",
        FrameInterval: &frameIntervalData,
    }
    callbackVideoCreateRequest:= "http://xxx.xx.xxxx"
    request.Body = &model.VideoCreateRequest{
        Callback: &callbackVideoCreateRequest,
        AudioCategories: &listAudioCategoriesbody,
        ImageCategories: listImageCategoriesbody,
        EventType: model.GetVideoCreateRequestEventTypeEnum().DEFAULT,
        Data: databody,
    }
    response, err := client.RunCreateVideoModerationJob(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }
}
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2. The console returns the submission result of the creation request and the
video moderation job creation result.
RunCreateVideoModerationJobResponse{"request_id":"dbbcb75d1a174bfa899a38be38fdd107", 
"job_id": "xxx"}

8.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withJobId of the
RunQueryVideoModerationJobRequest class to configure the ID of the review
task. After the configuration is complete, run the code.
package main
 
import (
    "fmt"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/core/auth/basic"
    moderation "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3"
    "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/model"
    region "github.com/huaweicloud/huaweicloud-sdk-go-v3/services/moderation/v3/region"
)
 
func main() {
   // Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
   // In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK and 
HUAWEICLOUD_SDK_SK.
   ak := os.Getenv("HUAWEICLOUD_SDK_AK")
   sk := os.Getenv("HUAWEICLOUD_SDK_SK")
 
    auth := basic.NewCredentialsBuilder().
        WithAk(ak).
        WithSk(sk).
        Build()
 
    client := moderation.NewModerationClient(
        moderation.ModerationClientBuilder().
            WithRegion(region.ValueOf("xxx")). //Replace xxx with the service region, for example, ap-
southeast-3.
            WithCredential(auth).
            Build())
 
    request := &model.RunQueryVideoModerationJobRequest{}
    request.JobId = "xxxx"   //Enter your job ID.
    response, err := client.RunQueryVideoModerationJob(request)
    if err == nil {
        fmt.Printf("%+v\n", response)
    } else {
        fmt.Println(err)
    }
}

2. The console returns the submission result of the query request and the video
moderation job query result.
RunQueryVideoModerationJobResponse 
{"request_id":"xxxx","job_id":"xxx","status":"succeeded","request_params":{"data":
{"url":"xxxx","frame_interval":5},"event_type":"default","image_categories":
["porn","terrorism","image_text"],"audio_categories":
["porn","ad","moan","abuse"],"callback":"xxx"},"create_time":"2022-07-30T08:57:11.011Z","update_tim
e":"2022-07-30T08:57:14.014Z","result":{"suggestion":"block","image_detail":
[{"suggestion":"block","category":"porn","ocr_text":"123","time":0,"detail":
[{"confidence":0.676015138626099,"category":"porn","suggestion":"block","label":"pornography"},
{"confidence":0.666015138626099,"category":"porn","suggestion":"review","label":"sexy_female"},
{"confidence":0.666015138626099,"category":"xxx","suggestion":"block","label":"leader"},
{"confidence":0.691423773765564,"category":"xxx","suggestion":"block","face_location":
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{"top_left_x":12,"top_left_y":13,"bottom_right_x":200,"bottom_right_y":240},"label":"leader"},
{"confidence":0.691423773765564,"category":"porn","suggestion":"block","face_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000},"label":"leader"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code","qr_c
ontent":"xxxxxxxxx","qr_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000}},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"porn","segme
nts":[{"segment":"xxx"},{"segment":"xx"}]}]}],"audio_detail":
[{"suggestion":"block","label":"porn","audio_text":"xxxxx","end_time":10,"start_time":0,"detail":
[{"confidence":0.999117187582349,"label":"porn","suggestion":"block","segments":
[{"segment":"xxx"}]},{"confidence":0.885117187582349,"label":"porn","suggestion":"block"}]}]}}
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9 Using the PHP SDK

9.1 Preparing a PHP Development Environment
To use the PHP SDK of Content Moderation, you need to configure the PHP
development environment.

1. Download PHP of a proper version from PHP official website and install it.
The php.7.x version is recommended for the Content Moderation SDK. The
following uses the PHP 7.0.32 version as an example.

NO TE

● The PHP installation directory cannot contain Chinese characters or special
characters.

● In the Windows operating system, if you run the php –v command, the command
output indicates that the specified module cannot be found, check whether the
extension_dir and include_path parameters in the php.ini file are correctly set.

1. Download the latest version of PhoStorm from PhoStorm's official website
and install it.

2. Start the PhpStorm development tool and choose File > Settings >
Languages & Frameworks > PHP to configure the PHP environment.

3. Select the PHP path on the top of the page, as shown in Figure 9-1. Then
click Apply.
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Figure 9-1 Configuring the PHP environment using PhpStorm

9.2 Importing a PHP SDK into a PHP Environment
You are advised to use Composer to install the PHP SDK for Content Moderation.
Composer is a dependency manager for PHP. It allows you to declare and install
dependencies in a project.

// Install Composer.
curl -sS https://getcomposer.org/installer | php
// Install the PHP SDK.
composer require huaweicloud/huaweicloud-sdk-php

After the installation is complete, you need to import the autoload file of
Composer.

require 'path/to/vendor/autoload.php';

9.3 SDK Calling Example

9.3.1 Moderation (Text)
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9.3.1.1 Text Moderation (V3)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
Change the value of Text in TextDetectionDataReq in the sample code to
the text to be detected. Then run the code.
For details about how to obtain the project ID, see Obtaining a Project ID.
<?php
namespace HuaweiCloud\SDK\Moderation\V3\Model;
require_once "vendor/autoload.php";
use HuaweiCloud\SDK\Core\Auth\BasicCredentials;
use HuaweiCloud\SDK\Core\Http\HttpConfig;
use HuaweiCloud\SDK\Core\Exceptions\ConnectionException;
use HuaweiCloud\SDK\Core\Exceptions\RequestTimeoutException;
use HuaweiCloud\SDK\Core\Exceptions\ServiceResponseException;
use HuaweiCloud\SDK\Moderation\V3\ModerationClient;
// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
$ak = getenv('HUAWEICLOUD_SDK_AK');
$sk = getenv('HUAWEICLOUD_SDK_SK');
$projectId = getenv('HUAWEICLOUD_SDK_PROJECT_ID');

$endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com";//Replace ap-southeast-3 with 
the region where the service is located.

$credentials = new BasicCredentials($ak,$sk,$projectId);
$config = HttpConfig::getDefaultConfig();
$config->setIgnoreSslVerification(true);
 
$client = ModerationClient::newBuilder(new ModerationClient)
  ->withHttpConfig($config)
  ->withEndpoint($endpoint)
  ->withCredentials($credentials)
  ->build();
$request = new RunTextModerationRequest();
 
$body = new TextDetectionReq();
$databody = new TextDetectionDataReq();
$databody->setText("text");  //Enter the text to be detected.
$body->setData($databody);
$body->setEventType("comment");
$request->setBody($body);
try {
  $response = $client->RunTextModeration($request);
  echo "\n";
  echo $response;
} catch (ConnectionException $e) {
  $msg = $e->getMessage();
  echo "\n". $msg ."\n";
} catch (RequestTimeoutException $e) {
  $msg = $e->getMessage();
  echo "\n". $msg ."\n";
} catch (ServiceResponseException $e) {
  echo "\n";
  echo $e->getHttpStatusCode(). "\n";
  echo $e->getErrorCode() . "\n";
  echo $e->getErrorMsg() . "\n";
}

2. The code is successfully executed if the text moderation result is displayed
on the console.
{
     "request_id":"d81702cfd3599e103030c3d52d6f955f",
     "result":{
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         "suggestion":"pass",
         "label":"normal",
         "details":[
         ]
     }
 }

9.3.2 Moderation (Image)

9.3.2.1 Image Moderation (V3)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Use Url or Image to configure the image information (Url is used in the
sample code) and run the code.
For details about how to obtain the project ID, see Obtaining a Project ID.
<?php
namespace HuaweiCloud\SDK\Moderation\V3\Model;
require_once "vendor/autoload.php";
use HuaweiCloud\SDK\Core\Auth\BasicCredentials;
use HuaweiCloud\SDK\Core\Http\HttpConfig;
use HuaweiCloud\SDK\Core\Exceptions\ConnectionException;
use HuaweiCloud\SDK\Core\Exceptions\RequestTimeoutException;
use HuaweiCloud\SDK\Core\Exceptions\ServiceResponseException;
use HuaweiCloud\SDK\Moderation\V3\ModerationClient;

// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
$ak = getenv('HUAWEICLOUD_SDK_AK');
$sk = getenv('HUAWEICLOUD_SDK_SK');
$projectId = getenv('HUAWEICLOUD_SDK_PROJECT_ID');

$endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com";//Replace ap-southeast-3 with 
the region where the service is located.
$credentials = new BasicCredentials($ak,$sk,$projectId);
$config = HttpConfig::getDefaultConfig();
$config->setIgnoreSslVerification(true);
 
$client = ModerationClient::newBuilder(new ModerationClient)
  ->withHttpConfig($config)
  ->withEndpoint($endpoint)
  ->withCredentials($credentials)
  ->build();
$request = new CheckImageModerationRequest();
 
$body = new ImageDetectionReq();
$listbodyCategories = array();
array_push($listbodyCategories,"porn");
$body->setUrl("http://www.xxxx.xxxx");
$body->setCategories($listbodyCategories);
$body->setEventType("head_image");
$request->setBody($body);
try {
  $response = $client->CheckImageModeration($request);
  echo "\n";
  echo $response;
} catch (ConnectionException $e) {
  $msg = $e->getMessage();
  echo "\n". $msg ."\n";
} catch (RequestTimeoutException $e) {
  $msg = $e->getMessage();
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  echo "\n". $msg ."\n";
} catch (ServiceResponseException $e) {
  echo "\n";
  echo $e->getHttpStatusCode(). "\n";
  echo $e->getErrorCode() . "\n";
  echo $e->getErrorMsg() . "\n";
}

2. The code is successfully executed if the image moderation result is displayed
on the console.
{"request_id": "69b424920668cb15e6d25eef879a023b", "result": {"suggestion": "block", "category": 
"image_text", "details": [{"suggestion": "block", "category": "image_text", "confidence": 1.0, 
"qr_location": {"top_left_x": 74, "top_left_y": 66, "bottom_right_x": 151, "bottom_right_y": 142}, 
"qr_content": "http://xxxxxx/xxxxx", "label": "qr_code"}, {"suggestion": "block", "category": 
"image_text", "confidence": 0.98779297, "label": "ad"}, {"suggestion": "block", "category": 
"image_text", "confidence": 1.0, "label": "qr_code"}], "ocr_text": "xxxxxxxxx"}}

9.3.3 Moderation (Video)

9.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withUrls of the
RunCreateVideoModerationJobRequest class to configure the URL of the video
to be reviewed (only the URL mode is supported). After the configuration is
complete, run the code.
For details about how to obtain the project ID, see Obtaining a Project ID.
<?php
namespace HuaweiCloud\SDK\Moderation\V3\Model;
require_once "vendor/autoload.php";
use HuaweiCloud\SDK\Core\Auth\BasicCredentials;
use HuaweiCloud\SDK\Core\Http\HttpConfig;
use HuaweiCloud\SDK\Core\Exceptions\ConnectionException;
use HuaweiCloud\SDK\Core\Exceptions\RequestTimeoutException;
use HuaweiCloud\SDK\Core\Exceptions\ServiceResponseException;
use HuaweiCloud\SDK\Moderation\V3\ModerationClient;
// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
$ak = getenv('HUAWEICLOUD_SDK_AK');
$sk = getenv('HUAWEICLOUD_SDK_SK');
$projectId = getenv('HUAWEICLOUD_SDK_PROJECT_ID');

$endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com";//Replace ap-southeast-3 with 
the region where the service is located.
$credentials = new BasicCredentials($ak,$sk,$projectId);
$config = HttpConfig::getDefaultConfig();
$config->setIgnoreSslVerification(true);
 
$client = ModerationClient::newBuilder(new ModerationClient)
  ->withHttpConfig($config)
  ->withEndpoint($endpoint)
  ->withCredentials($credentials)
  ->build();
$request = new RunCreateVideoModerationJobRequest();
 
$body = new VideoCreateRequest();
$listbodyAudioCategories = array();
array_push($listbodyAudioCategories,"porn");
$listbodyImageCategories = array();
array_push($listbodyImageCategories,"porn");
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$databody = new VideoCreateRequestData();
$databody->setUrl("http://xxx.xx.xxxx")
            ->setFrameInterval(5);
$body->setAudioCategories($listbodyAudioCategories);
$body->setImageCategories($listbodyImageCategories);
$body->setEventType("default");
$body->setData($databody);
$request->setBody($body);
try {
  $response = $client->RunCreateVideoModerationJob($request);
  echo "\n";
  echo $response;
} catch (ConnectionException $e) {
  $msg = $e->getMessage();
  echo "\n". $msg ."\n";
} catch (RequestTimeoutException $e) {
  $msg = $e->getMessage();
  echo "\n". $msg ."\n";
} catch (ServiceResponseException $e) {
  echo "\n";
  echo $e->getHttpStatusCode(). "\n";
  echo $e->getErrorCode() . "\n";
  echo $e->getErrorMsg() . "\n";
}

2. The console returns the submission result of the creation request and the
video moderation job creation result.
{"request_id": "dbbcb75d1a174bfa899a38be38fdd107", "job_id": "xxx"}

9.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withJobId of the
RunQueryVideoModerationJobRequest class to configure the ID of the review
task. After the configuration is complete, run the code.
For details about how to obtain the project ID, see Obtaining a Project ID.
<?php
namespace HuaweiCloud\SDK\Moderation\V3\Model;
require_once "vendor/autoload.php";
use HuaweiCloud\SDK\Core\Auth\BasicCredentials;
use HuaweiCloud\SDK\Core\Http\HttpConfig;
use HuaweiCloud\SDK\Core\Exceptions\ConnectionException;
use HuaweiCloud\SDK\Core\Exceptions\RequestTimeoutException;
use HuaweiCloud\SDK\Core\Exceptions\ServiceResponseException;
use HuaweiCloud\SDK\Moderation\V3\ModerationClient;
// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
$ak = getenv('HUAWEICLOUD_SDK_AK');
$sk = getenv('HUAWEICLOUD_SDK_SK');
$projectId = getenv('HUAWEICLOUD_SDK_PROJECT_ID');

$endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com";//Replace ap-southeast-3 with 
the region where the service is located.
$credentials = new BasicCredentials($ak,$sk,$projectId);
$config = HttpConfig::getDefaultConfig();
$config->setIgnoreSslVerification(true);
 
$client = ModerationClient::newBuilder(new ModerationClient)
  ->withHttpConfig($config)
  ->withEndpoint($endpoint)
  ->withCredentials($credentials)
  ->build();
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$request = new RunQueryVideoModerationJobRequest();
$request->setJobId("xxxx");      //Enter your job ID.
 
try {
  $response = $client->RunQueryVideoModerationJob($request);
  echo "\n";
  echo $response;
} catch (ConnectionException $e) {
  $msg = $e->getMessage();
  echo "\n". $msg ."\n";
} catch (RequestTimeoutException $e) {
  $msg = $e->getMessage();
  echo "\n". $msg ."\n";
} catch (ServiceResponseException $e) {
  echo "\n";
  echo $e->getHttpStatusCode(). "\n";
  echo $e->getErrorCode() . "\n";
  echo $e->getErrorMsg() . "\n";
}

2. The console returns the submission result of the query request and the video
moderation job query result.
{"request_id":"xxxx","job_id":"xxx","status":"succeeded","request_params":{"data":
{"url":"xxxx","frame_interval":5},"event_type":"default","image_categories":
["porn","terrorism","image_text"],"audio_categories":
["porn","ad","moan","abuse"],"callback":"xxx"},"create_time":"2022-07-30T08:57:11.011Z","update_tim
e":"2022-07-30T08:57:14.014Z","result":{"suggestion":"block","image_detail":
[{"suggestion":"block","category":"porn","ocr_text":"123","time":0,"detail":
[{"confidence":0.676015138626099,"category":"porn","suggestion":"block","label":"pornography"},
{"confidence":0.666015138626099,"category":"porn","suggestion":"review","label":"sexy_female"},
{"confidence":0.666015138626099,"category":"xxx","suggestion":"block","label":"leader"},
{"confidence":0.691423773765564,"category":"xxx","suggestion":"block","face_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":200,"bottom_right_y":240},"label":"leader"},
{"confidence":0.691423773765564,"category":"porn","suggestion":"block","face_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000},"label":"leader"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code","qr_c
ontent":"xxxxxxxxx","qr_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000}},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"porn","segme
nts":[{"segment":"xxx"},{"segment":"xx"}]}]}],"audio_detail":
[{"suggestion":"block","label":"porn","audio_text":"xxxxx","end_time":10,"start_time":0,"detail":
[{"confidence":0.999117187582349,"label":"porn","suggestion":"block","segments":
[{"segment":"xxx"}]},{"confidence":0.885117187582349,"label":"porn","suggestion":"block"}]}]}}

Content Moderation
SDK Reference 9 Using the PHP SDK

Issue 01 (2025-07-02) Copyright © Huawei Technologies Co., Ltd. 42

https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0072.html#section4
https://support.huaweicloud.com/intl/en-us/api-moderation/moderation_03_0072.html#section4


10 Using the Node.js SDK

10.1 Preparing a Node.js Development Environment
The JavaScript SDK of Content Moderation depends on the Node.js environment.

1. Download the recommended version from the Node.js official website and
install it. Node.js 8.x or later is recommended. The following uses Node.js
8.12.0 as an example.

2. Download the latest version of WebStorm from WebStorm's official website.
3. On the WebStorm page, choose File > Settings > Languages & Frameworks

> Node.js and NPM to configure the Node.js environment.
4. Select the Node.js and NPM installation path, as shown in Figure 10-1. After

selecting the target Node.js and NPM, click Apply at the bottom of the page
to complete the configuration.

NO TE

The JavaScript SDK of Content Moderation needs to depend on the moment-timezone
and moment modules. You can run the npm install command to install the SDK, or
click + in Figure 10-1 to install the SDK using a tool.
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Figure 10-1 Configure the Node.js environment

10.2 Importing a Node.js SDK into a Node.js
Environment

Before you use an SDK, install @huaweicloud/huaweicloud-sdk-core and
@huaweicloud/huaweicloud-sdk-moderation.

You are advised to use npm to install the SDK. Run the following command on the
CLI:

npm install @huaweicloud/huaweicloud-sdk-core
npm i @huaweicloud/huaweicloud-sdk-moderation 

10.3 SDK Calling Example

10.3.1 Moderation (Text)

10.3.1.1 Text Moderation (V3)
1. This section describes how to use the Text Moderation SDK by AK/SK

authentication.
Change the value of Text in TextDetectionDataReq in the sample code to
the text to be detected. Then run the code.
const core = require('@huaweicloud/huaweicloud-sdk-core');
const moderation = require("@huaweicloud/huaweicloud-sdk-moderation");
// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
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const ak = process.env.HUAWEICLOUD_SDK_AK;
const sk = process.env.HUAWEICLOUD_SDK_SK;
const projectId = process.env.HUAWEICLOUD_SDK_PROJECT_ID;

const endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com"; //Replace ap-southeast-3 
with the region where the service is located.
const credentials = new core.BasicCredentials()
                     .withAk(ak)
                     .withSk(sk) 
                     .withProjectId(project_id)

            
const client = moderation.v3.ModerationClient.newBuilder()
                            .withCredential(credentials)
                            .withEndpoint(endpoint)
                            .build();
const request = new moderation.v3.RunTextModerationRequest();
const body = new moderation.v3.TextDetectionReq();
const databody = new moderation.v3.TextDetectionDataReq();
databody.withText("test");
body.withData(databody);
body.withEventType("comment");
request.withBody(body);
const result = client.runTextModeration(request);
result.then(result => {
    console.log("JSON.stringify(result)::" + JSON.stringify(result));
}).catch(ex => {
    console.log("exception:" + JSON.stringify(ex));
});

2. The code is successfully executed if the text moderation result is displayed
on the console.
JSON.stringify(result)::{"request_id": "d81702cfd3599e103030c3d52d6f955f", "result": {"suggestion": 
"pass", "label": "normal", "details": []}}

10.3.2 Moderation (Image)

10.3.2.1 Image Moderation (V3)
1. This section describes how to use the Image Moderation SDK by AK/SK

authentication.
Use Url or Image to configure the image information (Url is used in the
sample code) and run the code.
const core = require('@huaweicloud/huaweicloud-sdk-core');
const moderation = require("@huaweicloud/huaweicloud-sdk-moderation");
// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
const ak = process.env.HUAWEICLOUD_SDK_AK;
const sk = process.env.HUAWEICLOUD_SDK_SK;
const projectId = process.env.HUAWEICLOUD_SDK_PROJECT_ID;

const endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com"; //Replace ap-southeast-3 
with the region where the service is located.
const credentials = new core.BasicCredentials()
                     .withAk(ak)
                     .withSk(sk)
                     .withProjectId(project_id)
const client = moderation.v3.ModerationClient.newBuilder()
                            .withCredential(credentials)
                            .withEndpoint(endpoint)
                            .build();
const request = new moderation.v3.CheckImageModerationRequest();
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const body = new moderation.v3.ImageDetectionReq();
const listbodyCategories = new Array();
listbodyCategories.push("porn");
body.withUrl("http://www.xxxx.xxxx");
body.withCategories(listbodyCategories);
body.withEventType("head_image");
request.withBody(body);
const result = client.checkImageModeration(request);
result.then(result => {
    console.log("JSON.stringify(result)::" + JSON.stringify(result));
}).catch(ex => {
    console.log("exception:" + JSON.stringify(ex));
});

2. The code is successfully executed if the image moderation result is displayed
on the console.
JSON.stringify(result)::{"request_id": "69b424920668cb15e6d25eef879a023b", "result": {"suggestion": 
"block", "category": "image_text", "details": [{"suggestion": "block", "category": "image_text", 
"confidence": 1.0, "qr_location": {"top_left_x": 74, "top_left_y": 66, "bottom_right_x": 151, 
"bottom_right_y": 142}, "qr_content": "http://xxxxxx/xxxxx", "label": "qr_code"}, {"suggestion": "block", 
"category": "image_text", "confidence": 0.98779297, "label": "ad"}, {"suggestion": "block", "category": 
"image_text", "confidence": 1.0, "label": "qr_code"}], "ocr_text": "xxxxxxxxx"}}

10.3.3 Moderation (Video)

10.3.3.1 Creating a Video Moderation Job
1. This section describes how to create a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withUrls of the
RunCreateVideoModerationJobRequest class to configure the URL of the video
to be reviewed (only the URL mode is supported). After the configuration is
complete, run the code.
const core = require('@huaweicloud/huaweicloud-sdk-core');
const moderation = require("@huaweicloud/huaweicloud-sdk-moderation");
// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
const ak = process.env.HUAWEICLOUD_SDK_AK;
const sk = process.env.HUAWEICLOUD_SDK_SK;
const projectId = process.env.HUAWEICLOUD_SDK_PROJECT_ID;

const endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com"; //Replace ap-southeast-3 
with the region where the service is located.
const credentials = new core.BasicCredentials()
                     .withAk(ak)
                     .withSk(sk) 
                     .withProjectId(project_id)
const client = moderation.v3.ModerationClient.newBuilder()
                            .withCredential(credentials)
                            .withEndpoint(endpoint)
                            .build();
const request = new moderation.v3.RunCreateVideoModerationJobRequest();
const body = new moderation.v3.VideoCreateRequest();
const listbodyAudioCategories = new Array();
listbodyAudioCategories.push("porn");
const listbodyImageCategories = new Array();
listbodyImageCategories.push("porn");
const databody = new moderation.v3.VideoCreateRequestData();
databody.withUrl("http://xxx.xx.xxxx")
 .withFrameInterval(5);
body.withAudioCategories(listbodyAudioCategories);
body.withImageCategories(listbodyImageCategories);
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body.withEventType("default");
body.withData(databody);
request.withBody(body);
const result = client.runCreateVideoModerationJob(request);
result.then(result => {
    console.log("JSON.stringify(result)::" + JSON.stringify(result));
}).catch(ex => {
    console.log("exception:" + JSON.stringify(ex));
});

2. The console returns the submission result of the creation request and the
video moderation job creation result.
JSON.stringify(result)::{"request_id": "dbbcb75d1a174bfa899a38be38fdd107", "job_id": "xxx"}

10.3.3.2 Querying a Video Moderation Job
1. This section describes how to query a video moderation job using the video

moderation SDK and AK/SK.
In the sample code, you can use withJobId of the
RunQueryVideoModerationJobRequest class to configure the ID of the review
task. After the configuration is complete, run the code.
const core = require('@huaweicloud/huaweicloud-sdk-core');
const moderation = require("@huaweicloud/huaweicloud-sdk-moderation");
// Hard-coded or plaintext AK and SK are risky. For security purposes, encrypt your AK and SK and 
store them in the configuration file or environment variables.
// In this example, the AK and SK are stored in environment variables for identity authentication. 
Before running this example, configure environment variables HUAWEICLOUD_SDK_AK, 
HUAWEICLOUD_SDK_SK, and HUAWEICLOUD_SDK_PROJECT_ID.
const ak = process.env.HUAWEICLOUD_SDK_AK;
const sk = process.env.HUAWEICLOUD_SDK_SK;
const projectId = process.env.HUAWEICLOUD_SDK_PROJECT_ID;

const endpoint = "https://moderation.ap-southeast-3.myhuaweicloud.com"; //Replace ap-southeast-3 
with the region where the service is located.
const credentials = new core.BasicCredentials()
                     .withAk(ak)
                     .withSk(sk)
const client = moderation.v3.ModerationClient.newBuilder()
                            .withCredential(credentials)
                            .withEndpoint(endpoint)
                            .build();
const request = new moderation.v3.RunQueryVideoModerationJobRequest();
request.jobId = "xxxxx";   //Enter your job ID.
const result = client.runQueryVideoModerationJob(request);
result.then(result => {
    console.log("JSON.stringify(result)::" + JSON.stringify(result));
}).catch(ex => {
    console.log("exception:" + JSON.stringify(ex));
});

2. The console returns the submission result of the query request and the video
moderation job query result.
JSON.stringify(result)::{"request_id":"xxxx","job_id":"xxx","status":"succeeded","request_params":
{"data":{"url":"xxxx","frame_interval":5},"event_type":"default","image_categories":
["porn","terrorism","image_text"],"audio_categories":
["porn","ad","moan","abuse"],"callback":"xxx"},"create_time":"2022-07-30T08:57:11.011Z","update_tim
e":"2022-07-30T08:57:14.014Z","result":{"suggestion":"block","image_detail":
[{"suggestion":"block","category":"porn","ocr_text":"123","time":0,"detail":
[{"confidence":0.676015138626099,"category":"porn","suggestion":"block","label":"pornography"},
{"confidence":0.666015138626099,"category":"porn","suggestion":"review","label":"sexy_female"},
{"confidence":0.666015138626099,"category":"xxx","suggestion":"block","label":"leader"},
{"confidence":0.691423773765564,"category":"xxx","suggestion":"block","face_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":200,"bottom_right_y":240},"label":"leader"},
{"confidence":0.691423773765564,"category":"porn","suggestion":"block","face_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000},"label":"leader"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code"},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"qr_code","qr_c
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ontent":"xxxxxxxxx","qr_location":
{"top_left_x":12,"top_left_y":13,"bottom_right_x":100,"bottom_right_y":2000}},
{"confidence":0.891423773765564,"category":"image_text","suggestion":"block","label":"porn","segme
nts":[{"segment":"xxx"},{"segment":"xx"}]}]}],"audio_detail":
[{"suggestion":"block","label":"porn","audio_text":"xxxxx","end_time":10,"start_time":0,"detail":
[{"confidence":0.999117187582349,"label":"porn","suggestion":"block","segments":
[{"segment":"xxx"}]},{"confidence":0.885117187582349,"label":"porn","suggestion":"block"}]}]}}
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